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Lesson Objectives 

 Learn how to setup QuickBooks payroll  

 Set up employee payroll information 

 Set up payroll schedules 

 Learn how to create and print a payroll cheques 

 Learn how QuickBooks tracks your payroll tax liabilities 

 Learn how to remit payroll taxes 

 Learn how to create T4s 

 Learn how to create Records of Employment 
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Payroll Overview 

This lesson is designed to demonstrate some of the QuickBooks payroll features. The way you process payroll for your 
company may differ from this lesson depending on which (if any) payroll service you subscribe to. Because payroll 
information is already set up in the exercise file, you will not go through the payroll setup process in this lesson. To 
calculate payroll, QuickBooks uses tax tables.  

QuickBooks calculates each employee’s gross pay, and then calculates taxes and deductions to arrive at the net pay. With 
QuickBooks, you can write the paycheque, record the transaction in your QuickBooks chequing account, keep track of your 
tax liabilities, and pay them. You, as the employer, must subtract taxes and other deductions before issuing an employee’s 
paycheque. Some typical paycheque deductions are Income taxes, Canada Pension Plan /Quebec Pension Plan (CPP/QPP), 
and Employment Insurance.  

You may also deduct for benefits such as a Registered Retirement plans (RRSP), or contributions to your company’s 
medical/dental plan. Then you must submit regular deposits of the withheld tax money (biweekly or monthly, depending 
on the size of your payroll), and file annual forms that list the total amounts you withheld from each employee’s 
paycheque. 

To do its payroll calculations, QuickBooks needs four kinds of information:  

 Information about your company - Besides the company name and address, this includes information about your 
Business Number from the CRA. You enter this information in the EasyStep Interview when you set up your 
QuickBooks company data file. (You can view most company information by choosing Company Information from the 
Company menu.)  

  Information about your employees - The QuickBooks Employee list stores general information about each of your 
employees, and specific information related to payroll (such as the employee’s Social Insurance Number, date of birth, 
salary or hourly rate, Federal and Provincial TD1 amounts, and miscellaneous additions, deductions, and company 
contributions). You can store payroll information that most have in common in employee defaults. Whenever you 
have a new employee to add, simply enter information that’s specific to that employee (name, address, and so on).  

  Information about your payroll items - QuickBooks maintains a list of items that affect the amount on a payroll 
cheque, including company expenses related to payroll. When you specify that you want to use payroll, QuickBooks 
creates a number of payroll items for you. You add others as you need them.  

 Tax tables for federal and provincial withholdings - QuickBooks uses tax tables to calculate payroll. You get the 
current tax tables and keep them current when you subscribe to the Intuit Payroll. Once you’ve set up your company, 
employee data, and payroll items, to run payroll you enter the number of hours worked during the pay period for each 
employee. QuickBooks calculates the gross wages for the employee, and then refers to its tax tables and the company 
and employee information you’ve entered to calculate all withholdings and deductions and to arrive at the net pay 
amount. QuickBooks also calculates your company payroll expenses (for example, your contributions to CPP and EI), 
and, if you want print paycheques. 

 



Lesson 12 — Doing Payroll with QuickBooks 6 Steps to Setting Up QuickBooks Payroll 

QuickBooks 2020 Student Guide 6 

6 Steps to Setting Up QuickBooks Payroll 

Payroll Overview 

QuickBooks Payroll can manage your small business payroll including wages, additions, deductions, company 
contributions and other payroll items. It tracks your payroll liabilities including CPP, EI, and Federal Tax. You will also print 
cheques and paystubs for your employees. QuickBooks helps you manage your T4’s and ROE’s at the appropriate time of 
the year.  

Before you process your first payroll run there are several steps to getting setup. The key steps to getting going in 
QuickBooks Payroll are the following: 

 Update QuickBooks - To ensure that your company deductions are correct, you must update QuickBooks to the latest 
Tax Table. A tax table is the method used by the CRA to determine withholding amounts. QuickBooks uses tax tables 
to determine the rates for tax amounts that must be withheld from employee paycheques. Because of the frequent 
changes to payroll withholding amount regulations, the tax tables in QuickBooks eventually become outdated. For 
example, if withholding information changes, you need a new tax table so that QuickBooks withholds the correct 
amount from each employee's wages.  

 Enable Payroll – by default the QuickBooks payroll feature is turned on. You can enable in the QuickBooks 
Preferences.  

 Setup Payroll Items - QuickBooks uses payroll items to track individual amounts on a pay cheque and accumulate 
year-to-date wage and tax amounts for each employee. There are payroll items for compensation, taxes, other 
additions and deductions, and company-paid expenses. You can assign these payroll items to different accounts as 
needed. When the payroll feature is turned on, QuickBooks automatically provides some payroll items for you. These 
include payroll items for salary, CPP, EI, and Federal Income Tax. To fully track your payroll, you may need to add 
more payroll items to the list. For example, employee additions such as employee purchases, and company-paid 
benefits. 

 Setup Payroll Preferences – Choose the preferences that work for your business situation.  

 Setup Payroll Defaults - The employee defaults are where you enter payroll information that most employees have in 
common, such as deductions for pensions, health insurance, or union dues. The default setup saves you time, because 
you enter this information only once. When you are setting up the payroll record for a new employee, QuickBooks 
automatically fills in the information you entered into the default setup. If you need to, you can customize any of the 
prefilled information for each employee. 

 Setup Payroll Schedules -  Payroll schedules allow you to group employees who have the same pay frequency in 
whichever way that helps make your payroll runs convenient and hassle-free. 
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Update QuickBooks  

 Choose Help > Update QuickBooks. 

 Click the Update Now button. 

 Click Get Updates. In most cases, QuickBooks automatically installs updates once it downloads them. Maintenance 
releases require that you authorize the update before it installs. Only users with Windows Administrator permissions 
can install updates. 

 To complete the installation of a maintenance release, close and reopen QuickBooks. You will be prompted to install 
the update: Click Install Now to start the installation of the maintenance release. Click Install Later to open 
QuickBooks without installing the maintenance release. 

Enable Payroll 

By default, the QuickBooks payroll feature is turned on. If it is not enabled do the following: 

 From the Edit menu, choose Preferences then click Payroll & Employees in the left panel. 

 Click the Company Preferences tab and select Full Payroll. 

 Click OK. 

QuickBooks maintains a list for everything that affects the amount on a payroll cheque and for every company expense 
related to payroll. This list is called the Payroll Item list. There are payroll items for compensation, taxes, other additions 
and deductions, and employer-paid expenses. QuickBooks uses payroll items to track individual amounts on a paycheque, 
and accumulated year-to-date wage and tax amounts for each employee. 
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Setup Payroll Items 

QuickBooks maintains a list for everything that affects the amount on a payroll cheque and for every company expense 
related to payroll. This list is called the Payroll Item list. There are payroll items for compensation, taxes, other additions 
and deductions, and employer-paid expenses. QuickBooks uses payroll items to track individual amounts on a pay cheque 
and accumulated year-to-date wage and tax amounts for each employee. QuickBooks adds some items to the list for you, 
and you can add others as you need them.  

For common payroll items, such as compensation and benefits, QuickBooks provides extra assistance so you can set them 
up quickly and accurately. You work directly with payroll items as you do payroll tasks. Behind the scenes, QuickBooks 
tracks your payroll liabilities in the Payroll Liabilities account (an Other Current Liability account) and your when you 
create any kind of payroll transaction in QuickBooks—whether it's a pay cheque, a payroll withholding amount payment, 
or an adjustment—QuickBooks expresses the transaction in terms of a payroll item.  

Every item on a paycheque is setup as a payroll item. There are 5 common types of payroll items in addition to the payroll 
items QuickBooks uses to track Federal Tax, EI and CPP. The 5 types are the following: 

• Wage  
• Addition 
• Deduction 
• Company Contribution 
• Other Tax 

To view the payroll item list in QuickBooks: 

 From the Employees menu, choose Manage Payroll Items then choose View/Edit Payroll Item List. 

 

 NOTES 
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QuickBooks includes some common payroll items that can be used by many businesses. If you need to create new payroll 
items, QuickBooks lets you add items to the Payroll Item List. You can add any of the 5 payroll item types available in 
QuickBooks. You’ll find examples of the 5 types of payroll items listed below.  

To add a Wage payroll item: 

 From the Employees menu, click Payroll Setup, then click Add or Edit Payroll Items. 

 Click the Payroll Item button and then click New. 

 Choose the type of payroll item Wage then click Next. 

 

 Select the type of Wages. You can choose from Hourly Wages, Annual Salary, Commission or Bonus.  
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 Click Next and then select Regular Pay or Overtime Pay. 

 Click Next. 

                  

 Enter a name for the Hourly Wage and then click Next. 

                           

 NOTES
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 Choose the expense account to track the wage expense and then click Next. 

                 

 Select the settings for the Record of Employment (ROE) Tracking. Select the Earnings option. Select the Reporting 
Period. (View the Help in QuickBooks for more information regarding the Insurable and Reporting Period settings) 

        

 NOTES 
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To add an Addition item: 

You must set up a separate payroll item for each addition your company makes to gross or net pay. Examples of payroll 
additions include tips, expense reimbursements, travel advances, and other additions to gross or after-tax pay. 

 From the Employees menu, click Payroll Setup and then click Add or Edit Payroll Items. 

 Click the Payroll Item button and then click New. 

 Choose the type of payroll item Addition then click Next. 

 Enter the Name for Addition and then click Next. 
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 Choose the Expense account for the payroll item and then click Next. 

 

                      
 

 Select the Record of Employment (ROE) Tracking options. 

 If required choose the Tax Tracking Type and then click Next. 

                      

  



Lesson 12 — Doing Payroll with QuickBooks 6 Steps to Setting Up QuickBooks Payroll 

QuickBooks 2020 Student Guide 14 

 Select the Taxes that apply to this addition. This will be determined by the type of addition being added to the 
employee paycheque. Click Next.  

 

                      
 

 Choose how to calculate this addition. You can choose to Calculate this item based on quantity or Calculate this 
item based on hours. Choose Neither if you want this to be based on a percent or a flat amount. 
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 If you choose, you can enter the Default rate and limit for the addition. Enter a Limit if required.  These fields can be 
left blank. Click Finish to complete the addition setup.  
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To add a Deduction: 

You must set up a separate payroll item for each deduction your company makes to gross or net pay. You must create a 
separate payroll item for each payroll deduction from gross or net pay. Examples of payroll deductions include union dues, 
loan repayments, employee-paid insurance, and employee contributions to a pension plan. 

From the Employees menu, click Payroll Setup and then click Add or Edit Payroll Items. 

 Click the Payroll Item button and then click New. 

 Choose the type of payroll item Deduction then click Next. 

 Enter the Name for Deduction and then click Next. 

 Enter name of the agency to which the liability is paid. This is the vendor to which the deducted amounts will be 
paid. In this example the agency is the union to which the union dues will be paid. Enter the number that identifies 
you to agency. This is the account or other identification number.  

 Choose the Liability Account. After the amount is deducted from an employee paycheques it is tracked in the liability 
account in this field. Click Next.  

                      

 

 NOTES 
  



Lesson 12 — Doing Payroll with QuickBooks 6 Steps to Setting Up QuickBooks Payroll 

QuickBooks 2020 Student Guide 17 

 Choose the Tax Tracking Type. Click Next. 

         
 

 Choose the Taxes that apply. Click Next. 

 Choose how to calculate this addition. You can choose to Calculate this item based on quantity or Calculate this 
item based on hours. Choose Neither if you want this to be based on a percent or a flat amount. Click Next. 

 Select the Gross vs. Net option. You can choose to calculate the deduction on gross pay or on net pay. Click Next. 

 

         
 Enter the Default rate limit.  Click Next. 

 Click Finish to complete the deduction setup. 
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To add a Company Contribution: 

You must set up a separate payroll item for each company-paid contribution your company makes. Examples of company-
paid benefits and expenses include health or life insurance paid by the company, company contributions to an employee's 
pension plan, or a per-kilometre travel allowance. From the Employees menu, click Payroll Setup and then click Add or 
Edit Payroll Items. 

 Click the Payroll Item button and then click New. 

 Choose the type of payroll item Company Contribution then click Next. 

 Enter the Name used in pay cheques and payroll reports. Click Next. 

           

 Enter name of the agency to which the liability is paid. This is the vendor to which the contributed amounts will be 
paid. In this example the agency is the investment company to which the RRSP contribution is made. Enter the 
number that identifies you to agency. This is the account number or other identification number.  
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 Choose the Expense account. Since this is a company-paid contribution, you’re required to choose and expense 
account to record the expense portion of the transaction. Click Next. 

 

                      
 

 Select the Record of Employment (ROE) Tracking. Click Next. 
 Choose the Tax Tracking Type. Click Next. 
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 Select the Taxes that affect this Company Contribution. Click Next. 
 

                      
 

 Select how to calculate the Company Contribution. Click Next. 
 Enter the Default rate and limit. Click Finish. 

 

 NOTES 
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To add an Other Tax: 

You must set up a separate payroll item for each company-paid or employee-paid tax. Examples of other Taxes are WSIB 
in Ontario or WCB in other provinces. From the Employees menu, click Payroll Setup and then click Add or Edit Payroll 
Items. 

 Click the Payroll Item button and then click New. 

 Choose the type of payroll item Other Tax then click Next. 

           

 Select Tax is paid by the employee or Tax is paid by the company. Click Next. 
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 Enter the Name used in pay cheques and payroll reports. Click Next. 

 

 Enter the necessary information for the Agency for company-paid liability. Click Next. 

 

 Choose the Tax tracking type.  
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 Enter the Default rate and limit. Click Next. 

          

 Select the Payroll Items to which this tax will be applied. Click Next. 

 
 

 NOTES 
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 Select any Pre-Tax deductions that will reduce wages subject to this tax. Click Finish to complete the item setup. 

 

 

 

 NOTES 
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Setup Payroll Preferences 

There are several payroll preferences available for selection in the Company Preferences. To edit the payroll preferences, 
click, Edit > Preferences menu > click Payroll & Employees. 

Edit the following preferences as needed in your business.  

 Recall quantity field on pay cheques - Determines whether QuickBooks automatically carries forward quantities 
from the pay cheques with the latest transaction date (this may not be the last pay cheque you actually entered.)  
Select this option when you have a fixed quantity that recurs from pay cheque to pay cheque and you want this 
quantity carried forward. 

 Recall hour field on pay cheques - Determines whether QuickBooks automatically carries forward hours from the pay 
cheques with the most recent transaction date as seen in the register. Select this option when you have fixed hours 
that recur from pay cheque to pay cheque and you want the quantity carried forward. If you checkmark "Recall hour 
field on pay cheques", QuickBooks carries forward hours for all payroll items that are based on hours that are also 
part of the employee's payroll record. 

 Job Costing and item tracking for pay cheque expenses - On pay cheques, QuickBooks prorates company-paid taxes 
by your jobs, classes, and/or service items, using the ratios it derives from the way you split up earnings in the Earnings 
table. When you create or edit payroll items that are additions or company contributions, QuickBooks displays a 
checkbox called Track Expenses by Job on the "Name used in pay cheques and payroll reports" screen of the payroll 
item setup wizard. If you select this box, QuickBooks prorates those items on employee pay cheques the same way it 
does company-paid taxes, as described above. 

 

 NOTES 
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 Printing Preferences – View the Help file to find out more details about your printing options for QuickBooks payroll. 

 Employee Defaults - When you set up your employee defaults, you enter payroll information that most employees 
have in common, such as deductions for taxes, health insurance, or union dues. QuickBooks saves the information so 
that you won't have to re-enter it when you set up the payroll record for an individual employee. If there are a few 
exceptions, you can change them on an individual basis whenever you need to. Any changes you make to the default 
setup will appear every time you enter information for a new employee. 

 
 

 
 

 NOTES 
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Setup Employee Defaults 

QuickBooks stores information about each employee, but it doesn’t require you to enter the same information over and 
over. When you have information that applies to most of your employees, you can enter it into your employee defaults. 
Then, when you add an employee, QuickBooks automatically adds the information stored in the defaults to the employee 
record. You just need to add or change any information that is different for a particular employee. 

To setup employee defaults: 

 From the Employee Centre, choose Change New Employee Default Settings from the Manage Employee 
Information menu button. 

 

 Set the default Payroll Schedule, or Pay Frequency.   

 Setup the Earnings items. 

 Set the default Additions, Deductions and Company Contributions. You’ll use the payroll items that you previously 
setup for your company.  

 Use the Taxes and TD1 button to set up the taxes and TD1 information (see Employee Setup section for more 
information) 

 Click Vacation Pay… to setup vacation pay details (see Employee Setup section for more information). 

 Click Sick/Vacation to modify the default settings (see Employee Setup section for more information). 

 Click OK to close the Employee Defaults window.
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Set Up Payroll Schedules 

Payroll schedules allow you to group employees who have the same pay frequency in whichever way that helps make your 
payroll runs convenient and hassle-free. You can use payroll schedules to group together employees in whichever way 
makes the most sense for you to effectively run your payroll and your business. However, all employees grouped in 
the same payroll schedule must have the same pay frequency (for example, weekly, bi-weekly, semi-monthly, and so 
on). 

In other words, you can set up multiple payroll schedules for the same pay frequency. For example, even if you're paying all 
your employees weekly, you could set up separate payroll schedules to group together: 

• Salaried employees and hourly employees. 
• Employees who are paid via Direct Deposit and those who are paid by regular cheque. 
• Employees by location or department, class, or job. 

Note: You can set up a maximum of 200 payroll schedules. 

To setup a payroll schedule: 

 From the Employees menu, click Payroll Setup and then click Add or Edit Pay Schedules.  

 Click the Payroll Schedule menu button and then click New. 

 
 

 NOTES 
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 Enter a name for your payroll schedule in the What do you want to name this payroll schedule? field. 

 Press Tab and select the pay frequency. 

 Press Tab and select the pay period end date for the next period you wish to run payroll. 

 Press Tab and select the date that should appear on the cheques for the next period you wish to run payroll. 

 Press Tab and select the day that should appear on the cheques for the next period you wish to run payroll. 

 

 Click OK. 

 Repeat as needed to set up your pay schedules. 

Note: Now that you’ve set up the pay schedules, you can assign each employee to the appropriate pay schedule. 

 

 NOTES 
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Employee Setup   

QuickBooks defines an employee as someone you give a T4 or Relevé 1 form to at the end of the year. You pay employees 
with pay cheques and withhold taxes for them. Set up all those who fall into this category as employees. If you hire 
independent contractors, add them as vendors (not employees). The Employee list stores general information about each 
employee as well as payroll information. 

To add a new employee: 

 Click Employee Centre. 

 On the Employees tab, click New Employee.  

 Click the Personal tab to enter the employee’s Name, SIN number, Gender and Date of Birth. 
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 Click the Address & Contact tab to enter the employee contact information. Enter the necessary information. This 
information will display on the employee paycheques and paystubs as well as the T4 form. 

 Click the Additional Info tab to access custom fields, billable rate, and employee identification number. 

         
 
 

 NOTES 
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 Click the Payroll Info tab. This is where you set up the employee pay schedule, additions, deductions, and company 
contributions for the employee. 

 Choose a Payroll Schedule if appropriate for the employee.  

 Choose the Earnings items for this employee. Each of the payroll items selected from the Item Name menu will 
display on the employee paycheque/Paystub. Choose the items that will be used for the employee’s regular pay. 
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 Use the buttons on this tab to access additional information for direct deposit, taxes, and sick/vacation pay. Click 
Taxes and TD1. Choose the employee’s Tax Table. You can update the Federal TD1 and Provincial TD1 if necessary 
in this window. Add any Additional Tax, this employee has requested to be deducted from each paycheque. 

 Click Ok to save the information. 

   
 

 NOTES 
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 Click the Accrual Hours button to add accrual hours for this employee. You use this window to set up how your 
employees accrue time (such as sick time or time-in-lieu), how many hours they currently have available, and how 
many hours they have used so far this year. Click Ok to save the information. 

   

 Click Vacation Pay…to setup vacation pay for this employee. Do the following to setup vacation pay for the 
employee: 

a. Select "Retain" if you would like QuickBooks to calculate and accrue vacation pay through the year. 

b. Select "Pay every period" if you would like QuickBooks to calculate the employees' vacation pay and add 
it to each of their cheques. 

c. In the Percentage field, enter the percentage of the employees' pay that QuickBooks should use to 
calculate vacation pay (usually 4% or 6%). 

d. From the "Earnings that accrue vacation" list, choose the payroll items QuickBooks should use to 
calculate the employees' vacation pay. 

Note: In some provinces, you should select earnings items only. In other provinces, you may need to also calculate 
additional vacation pay on vacation pay that is paid out to the employee. If you are not sure which method applies to you, 
check with your accountant. 
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 Click the Employment Info. tab and enter the Hire Date. 

 Click OK to save the employee record.  

 

 

 NOTES 
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Running Payroll 

Now that you have completed the 6 important steps to setup your company payroll, you’re ready to run your first payroll.  

You can set up payroll schedules or run payroll without a schedule. A payroll run that is set up to occur at a regular 
frequency is scheduled, while payroll that you might run only for special circumstances or outside your regular payroll run 
is "Unscheduled Payroll". 

Use payroll schedules for regular payroll, and Unscheduled Payroll for other instances when you need to pay your 
employees outside their pay cycle. You set up payroll schedules, while Unscheduled Payroll runs are done on-the-fly, as 
and when you need to pay an employee off-cycle. 

Pay Employees using a Payroll schedule 

 In the Employee Centre, click the Payroll tab. 

 In the Create Pay Cheques section, click the Payroll Schedule to run.  

 Click the Start Scheduled Payroll button. 
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 Select the employees to pay in this payroll run. 

 Verify the information is correct including the Pay Period Ends, Cheque Date and Bank Account. Verify the correct 
list of employees are selected to be paid.  

 Click Continue. 

 

 

 NOTES 
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 To review all paycheques, click on the Open Pay Cheque Detail… button or, to review one paycheque, click the 
employee’s name. 
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 Review the paycheques as needed.  
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 Click Save & Next to review all paycheques or click Save & Close to return to the Review and Create Paycheques 
window. 

 Click Create Paycheques. 

 

NOTE: QuickBooks writes a payroll cheque for each employee in the payroll schedule for the correct net amount, 
showing the deductions in the voucher area. QuickBooks confirms that you have created the paycheques. You can 
then choose to print the paycheques. 

 NOTES
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 Click Print Pay Cheques to print or click Print/Email Paystubs.  

 

 When you click Print Pay Cheques you can select the Pay Cheques to Print. Enter the First Cheque Number and then 
click OK to print the selected cheques. 
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 Alternatively, you can choose Print/Email Paystubs. From this window you can select paystubs to be printed or to 
email to employees.  

 

 Click Email. Review the message to understand how your employees will access their emailed paystubs. Click OK. 
Note: If you’re emailing paystubs to employees, you should add the employee’s email address to the employee 
record. If it is not added, you will need to add the email from the next window.  
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 Before sending the employee paystub, QuickBooks lets you review and update the email information as needed. Click 
Send Now to send the email.  
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Pay Employees using Unscheduled Payroll 

 In the Employee Centre, click the Payroll tab. 

 Click the Start Unscheduled Payroll button. 

 Follow the same process as listed above for scheduled payroll. 

 

 



Lesson 12 — Doing Payroll with QuickBooks Viewing Paycheques 

QuickBooks 2020 Student Guide 45 

Viewing Paycheques 

QuickBooks records payroll cheques in the Employee Centre. You can view historical employee paycheques 

To view the paycheque from the Employee Centre: 

 From the Employee Centre, click the Employees tab. 

 Click the employee to view. The employee’s paycheques display in the Transactions tab. 

 Double-click the Paycheque and QuickBooks will display the cheque. 

 Click Pay Cheque Detail…to view more details. 

 

 Click Save & Close to close the paycheque. 
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Pay Payroll Liabilities 

When it’s time to deposit payroll taxes with your deposit institution, use the Liability cheque window to fill out a 
QuickBooks cheque. Most businesses must send a cheque to the CRA or Revenu Québec for last month's payroll 
deductions by the 15th of the current month. Check with the CRA or your accountant to see what's right for your business.  

When you are ready to pay your payroll liabilities, QuickBooks lets you choose all or just some of them to pay and creates 
cheques to pay them. You can also add penalties, expenses and discounts to the payroll liability cheque. 

Before your payroll liabilities can be paid, you must have a  payee name associated with each liability. 

To pay payroll liabilities: 

1. On the Pay Liabilities tab of the Payroll Centre, click the Pay Liabilities icon. 
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2. In the Date Range window, enter the start and end dates of the period. Then click OK. 

 

 

Note: Check the dates carefully as QuickBooks uses them to create the PD7A and Payroll Liability Balances reports. 

3. In the Pay Liabilities window, select the To be printed checkbox to print the liability cheques using QuickBooks, or 
clear it if you are writing them by hand. 

4. Choose the Chequing Account to write the cheque from (not your Payroll Liabilities account!). 

 

5. In the Payment Date field, enter the date that you want to appear on your liability payments. 

6. Verify the date range shown in the Show Payroll Liabilities "from / through" fields. 

7.  Select the liabilities you want to pay. 
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Some liabilities can be selected and paid only as a group. For example, CPP Employee, CPP Employer, EI Employee, EI 
Employer, Federal Income Tax Withholding, and other federal withholding items can only be selected together. 

8. (Optional) If you want to pay less than the full amount of a liability you marked, enter the amount you want to pay 
in the Amt. To Pay field. 

9. Click Review. If you're satisfied with the review, click Save & Close. 

10. QuickBooks writes a single cheque for all liabilities paid to the same vendor. 

 

 

 NOTES
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Issue T4 Forms 

 
In January or February, you need to create T4 for your employees and the CRA. In Québec, you also need to Releve 1 Slips 
for your employees and Revenu Québec.  
 
QuickBooks can create and print T4 slips for you. It can also create a T4 Summary report to help you fill out the T4 
Summary form for the CRA.  
 

1. If you have a page-oriented printer, QuickBooks printsT4 slips on blank paper or preprinted forms from CRA. 
2. Create and review a T4 slip for each employee who worked for you at any time during the last year.  
3. Make any adjustments that are needed. 
4. If you are printing on pre-printed forms, test the alignment of the T4 slips on your printer. 
5. Print T4 slips for employees and E-File T4 slips for the CRA. 
6. Distribute the printed slips. Usually, the employee receives two copies. If you printed slips for the CRA instead of 

E-Filing them, the CRA receives one slip. 
7. Create a T4 Summary report to summarize the T4 slips for your T4 Summary form. 

 
Note: Employees should receive a T4 slip for each province or territory they worked in for your company.  
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To create T4 Forms for Employees 

1. From the Employee Centre, click the File Forms tab. 

2. Click the T4 line from the list of Forms. 

3. Click Process Form. 
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4. Choose the Form in the Form menu. Choose the Year.  
5. Select the employees.  

 

6. Click Review to review each employee’s T4 form. 
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7. Click Next to review each T4 form.  
8. Click OK after you’ve completed your review.  
9. From this window you can choose to Print, Email (T4’s to employees) or EFILE your T4 forms.  
10. Click Done. 
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Review Activities 

 From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays the Open or Restore 
Company window.  

 Select Restore a backup copy and click Next.  

 Select Local backup and click Next.  

 In the Open Backup Copy window, navigate to the appropriate directory.  

 Select the qblesson.qbb file, and then click Open.  

 In the Open or Restore Company window, click Next.  

 Navigate to your directory.  

 In the File Name field of the Save Company File As window, type Lesson12 and then click Save.  

 Enter the Password: QBDT2020! 

 Click OK when you see the message that the file has been successfully restored. 
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 Setup a Salary Payroll item in QuickBooks called Management Salary. Track the item to the Payroll Expense account. 

 Setup a payroll item in QuickBooks to pay hourly employees. Call the payroll item Construction Hourly. Track the item 
to the Payroll Expense account. 

 Setup an item to track Union Dues for the hourly construction employees. The Union name is Construction Union. 
Track the item to Box 44 on the T4. This item has no effect on any taxes for the employees. The amount deducted 
from each cheque is a flat amount of $25.00. It will be calculate on Gross Pay. 

 Setup the Employee Defaults to include Construction Hourly item, Union Dues. The pay frequency is Semi-Monthly. 
All employee are based in Ontario with default TD1 amounts. Vacation is calculated at a rate of 4%. 

 Add an hourly employee using the following information: 

Name: Sam Bell 

Birthdate: October 12, 1973 

Phone: 416-456-4984 

Address: 3898 Halsey Ave. 

           Toronto, ON. M3B 2W6 

Hire Date: First day of the current month 

SIN: 536 864 262 

 Add an hourly employee using the following information: 

Name: James Persson 

Birthdate: April 12, 1979 

Phone: 416-456-4000 

Address: 2409 Queen Elizabeth Road. 

           Toronto, ON. M3B 2W9 

Hire Date: First day of the current month 

SIN: 588 890 558  
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 Add an hourly employee using the following information: 

Name: Joel Montanez 

Birthdate: November 21, 1975 

Phone: 416-699-1554 

Address: 842 Robertson St. 

           Toronto, ON. M3N 2N8 

Hire Date: First day of the current month 

SIN: 474 449 428 

Hourly Rate: $25.00 

 Add a salaried employee using the following information: 

Name: Jane Stewart 

Birthdate: August 21, 1955 

Phone: 519-720-4828 

Address:  2738 Birkett Lane 

             Brantford, ON. N3T 2Z8 

Hire Date: First day of the current month 

SIN: 330 353 400 

Salary: $80,000 per year 

 Run your first payroll for the 15th of the current month. Pay employees using 80 hours per two-week period.  

 Run your second payroll for the last day of the current month. Pay employees using 80 hours per two-week period. 

 


